CHAPTER 1

Microsoft Project 2016 - Level 3

CusToMm FIELDS

: : INFOcus

Project provides a huge number of built-in fields. However, you
won’t always be able to find one that displays the exact information
you want or even how you want it to be displayed. When this
happens you can create custom fields to track information that the
built-in fields don’t record. For instance, you can create fields with
lookup tables, fields that display information visually, and quite a lot
more.

In this session you will:

gain an understanding of the custom fields
learn how to create and name custom fields
learn how to insert custom fields

learn how to use a formula in a custom field to calculate a
field value

learn how to modify formulas in custom fields
learn how to test a formula in a custom field
gain an understanding of graphical indicator custom fields

learn how to create custom fields with graphical
indicators

learn how to create a lookup custom field

v"learn how to create a code mask for an outline code
lookup table

v learn how to enter values in a lookup table
v learn how to use a lookup table.
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UNDERSTANDING CUSTOM FIELDS

Although Project comes complete with a myriad
of fields, you may find situations when there isn’t
a built-in field available for tracking the specific
information you need for your project. This is

where custom fields are useful. For instance, you
can use formulas to calculate values or build lists of
values from which you can choose. Like built-in
fields, custom fields come in various data types.

Available Task
custom fields
for the selected
data Type
(Text), hence
the default field
names — Textl,
Text2, etc.

Custom Fields X
Field
(®) Task (O Resource Project Type: Text ~
Field | 2
Text1
Text2
Text3
Text4
Text5
Texts
Text?
o v
Rename... Delete Add Field to Enterprise Impaort Field...
Custom attributes
® None () Lookup... | O Formula...
Calculation for task and group summary rows
@ Mone Rollup Use formula

Calculation for assignment rows

@ Mone O Roll down unless manually entered

Values to display

@ Data O

Help

Graphical Indicators..,

Cancel

The Custom Fields Dialog Box

Although you can quickly create simple custom fields using the Insert Column or Add New Column
features, if you need to create more complex custom fields you will need to use the Custom Fields
dialog box, as shown above, which is available via the Custom Fields command on the Project tab.

Field type

Data type

Custom attributes

Calculation for
task and group
summary rows or
Calculation for
assignment rows

Values to display

The first thing you must specify when creating a new custom field is the view in which
it will be available. For instance, Task custom fields will appear in Task views, while
Resource custom fields will appear in Resource views.

You can specify the data type for the custom field based on what you are storing in
the field. Cost holds money; Date hold dates; Duration holds the same type of data
as the Duration field you've seen in a Gantt Chart; Start and Finish fields are usually
used by Project for storing start and finish dates for interim plans but if you don’t use
interim plans, you can use these fields to store other custom dates; Flag fields are
used to tag tasks or resources with Yes/No values (such as whether a task is being
done at a fixed price or for tasks that you need to do extra quality assurance on);
Number stores numbers other than cost and duration (e.g. the square metres of walls
to be painted); Text fields can store up to 255 characters; and Outline Code fields
are a special type which you can use to set up a hierarchy of values such as
department numbers.

You can use these options to either create a Lookup table of valid values to pick
from or assign a Formula to a custom field to calculate values.

You can specify how you want Project to calculate task and summary rows. For
instance, you could have Project roll up the values to the summary row, like the
Duration does or you could use a formula to calculate it. Alternatively, you could tell
Project how to calculate the values for assignment rows down from the task value.

You can choose to display the values in the custom fields as either data or graphical
indicators, such as red, orange and green circles.
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CREATING CUSTOM FIELDS

Custom fields are initially named with a default based on the Text data type. To make a custom
name that identifies the data type on which they field easier to use the first thing you will need to do
are based. For instance, the Costl field is based is to rename it to something more meaningful.

on the Cost data type, while the Text1 fields is

e Custom Fields *
Try This Yourself: g
) ) (®) Task (O Resource Project Type:
Before starting this o &
$ © exercise you MUST open Numbert
ST the file Custom Number2
. Mumber3
Fields_1.mpp... Numbers
. . MNumbers
0 Click on the Project tab, Numbers
then click on Custom Number? v
Flelds In the Propertles Rename... Delete Add Field o Enterprise... Import Field...

group to display the
Custom Fields dialog box

Custom attributes

@ none O Lookup... Q Formula...

Let’s Cl’eate tWO ﬁelds for Calculation for task and group summary rows
traCking WOfkerS’ Output. . @None ORollup: Maximum Use formula
e Ensure that TaSk iS Calculation for assignment rows
8 8 . @ MNone O Roll down unless manually entered
selected in Field, then click
on the drop arrow for Type Values to display
and select Number to @pata O | Graphical Indicatars...
display the custom number Remame Field %
fields Help [ ox . ror Numbert
Mew name for ‘Mumber1’:

Ensure that Number1 is Number?
selected in Field, then click e p—
on [Rename] to display the
Rename Field dialog box

Custom Fields X

o Type Area (sq m), then _

click on [OK] to rename it Field
@Task OResource Project Type:
Notice that the field’s new Field [~
name appears, followed by Area (sq m) (Number1) J—— »
i Mumber2 ustom Flelds
its default name... Number3 s
Mumberd -

e Repeat StepS 3 and 4 to NE:b::S @) Task () Resource Project Type:
rename Number2 as Avg Numbers [ [~
Area Per Day Number? Area (sq m) (Number1)

. = = |A\rg Area Per Day (Number2)

Click on [OK] to close the Rename... Delete | Number3
Custom Fields dialog box Numbers
o Mumbers
Numberg
MNumber?

R v

e Rename.., Delete Add Field to Enterprise... Import Field...

For Your Reference... Handy to Know...
To create a custom field: e You can make as many or as few custom
1. Click on the Project tab, then click on fields as desired while you have the Custom
Custom Fields in the Properties group Fields dialog box open.

2. Click on Task or Resource

3. Select the appropriate Data type, click on
the field name, click on [Rename], then type
the new field name
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INSERTING CUSTOM FIELDS

Once you have created a custom field, you are of their field name. You can also locate them by
then ready to insert it into the appropriate table. searching on their default field name. This is
Like built-in fields, you can search for them using extremely helpful if you know you’ve created a
the Insert Column command by typing the start Cost field, for example, but can’t recall its name.
. area (sqm) ( Numberl ) % Phys. %  Act. Rem. Act.
. ask Name - Comp~ Comp. = Dur ¥ Dur ¥ Cost
Try This Yourself: 1 |4 Plans and site PO ns 0% 0% odays 38days S0,
y: y:
2 Create Site Plans NA NA 0% 0% Odays  2days S0,
Continue using the 3 Arrange Council Permits NA NA 0% 0% 0 days 1day 50.
[} g fle Wlth thlS 4 Prepare Site NA NA 0% 0% 0days Sdays S0.
IS i_" prev'qus I . 5 Organise Materials NA NA 0% 0% 0 days 1day $0.
(‘B L exercise, or Open the f||e 6 Lay Foundations NA NA 0% 0% Odays 12days S0.
Custom F|e|ds_2mpp 7 Plumbing for Sewerage NA NA 0% 0% Odays 2days 0.
8 Pour Slab NA NA 0% 0% 0days  2days $0.
o CI|Ck on the V|eW tab 9 Foundations Complete NA NA 0% 0% Odays  Odays S0.
click on Gantt Chart in e
the Task Views group,

i i Area Act. % Phys.%  Act Rem. Act.
then click on Tables in Task Name v m) - > | Act. Start '_Fintizh ~ Comp~ Comp. ~ DuT’. >~ Dun  ~ Cctst
the Data group and 1| 4 Plans and Site 0 NA NA 0% 0% Odays 38days $0.
select Tracking to 2 Create Site Plans 0 | NA NA 0% 0% Odays  2days s0.
dISplay the Tracking 3 Arrange Council Permits 0 NA NA 0% 0% 0 days 1day S0.

4 Prepare Site ] NA NA 0% 0% Odays  Sdays S0,
table 3 Organise Materials 0 NA NA 0% 0% 0 days 1day 50.
e R|ght'CI|Ck on the ACt ? LayFoL-mdations 0 NA NA 0% 0% Odays 12days S0.
7 Plumbing for Sewerage 0 NA NA 0% 0% Odays  2days $0.
Start column, select g Pour Slab 0 NA NA 0% 0% Odays  2days 40.
Insert Co | umn, then 9 Foundations Complete 0 NA NA 0% 0% Odays  Odays S0.
type ar e
Notice that the field’s
D PIEE S == . en v\ Comp | Comp < |- b
default name which is 1" | Plans and site 0 MR - NA 0% 0% odays 38d
shown in parentheses... 2 | createsite plans 0 Numbert- NA 0% 0% | odeys  2d
3 Arrange Council Permits 0 mtmg::% MNA 0% 0% 0 days 1c
e Press Enterl to insert the 3 | Prepare Site 0 Humbertd NA 0% 0% Odays 5¢
Area(sqmycoumn || | e
Lot's insertthe second || 1 prmrersee Wiy 06 0 e
field but this time we’ll 5 | rounaat o
9 Foundations Complete 0 HNumberd NA 0% 0% 0 days od
search on the default
field name... e
o Repeat Step 2, but thIS o Area (sq Avg Area 3 Act. % Phys. % Act, Rem.
q ask Name  'm v |PerDay ~ ActStat v Finish + Comp~ Comp. v Dur. ~+ Dur
time type num 1 |4 plans and site 0 ] o NA NA % 0% 0da
ys 38d
N ” fth N b 2 Create Site Plans 0 0 NA MNA 0% 0% 0days 2d
ow a O € .Um er 3 Arrange Council Permits 0 0 NA NA 0% 0% 0 days 1c
custom fields will be 4 Prepare Site 0 0 NA NA 0% 0% Odays 5d
listed 5 Organise Materials 0 0 NA NA 0% 0% Odays 1o
6 Lay Foundations 0 0 NA NA 0% 0% Odays 12d
e Click on (Avg Area Per 7 Plumbing for Sewerage 0 0 NA NA 0% 0% Odays 2d
i i 8 Pour Slab 0 0 NA NA 0% 0% Odays 2d
Day) © Insert th|S 9 Foundations Complete 0 0 NA NA 0% 0% 0days 0d
custom field
For Your Reference... Handy to Know...
To insert a custom field: o Before adding custom fields to a standard
1. Right-click on the heading of the column to table, you might wish to save the table as a
the right of where you want to insert the new table. To do this, click on the View tab,
custom field click on Tables, select Save Fields as a

2 Click on Insert Column New Table, then type a new name.

3. Start typing the field name or default field
name, then click on the desired field
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CREATING A FORMULA IN A CusToM FIELD

If you want to display or work with values that do formula to our Avg Area Per Day custom field to
not exist in fields, you can create a custom field calculate the average area per day value. The
and add a formula to create the desired values. formula we want to create is the area in square
For instance, in this exercise we will add a metres divided by the actual duration.
S Area (sq Avg Area . Act. % Phys. % Act. Rem.
o ask Name > m) ~ PerDay ~ ActStart v Finish = Comp~ Comp. ¥ Dur ~ Dun ~
Try ThIS Yourself. 22 Install Bathroom 0 0 NA NA 0% 0% Odays  2days
23 Final Electrical Fittings 0 0 NA NA 0% 0% Odays  3days
@ Contlnue us'ng the prev'ous f||e 24? Firfal Plumbing Fittings 0 0 NA NA 0% 0% 0 days 2 days
= o q q 2 25 Paint External 710 o NA NA 0% 0% Odays  Sdays
@ [T V_Vlth this exerqse, or open the 26 Paint internals 925 0 NA NA 0% 0% Odays  6days
n file Custom Fle|dS_3mpp 27 Council Appraoval 0 ] NA NA 0% 0% 0days 1day
28 Construction Completed 0 0 NA NA 0% 0% Odays  Odays
o In the Tracking table, under
Fit Out click in the Area (sq m) o
column for Paint External and
type 710, click in the Area (sq
m) Column f0r Paint intel’na|S e Formula for 'Avg Area Per Day' hd
and type 925, then press [Enter] Edit formula
e Display the Custom Fields fvg Area Per Day =
dialog box, select Number in
Type, click on Avg Area Per
Day, then click on [Formula] to
display the Formula dialog box =17 [almoo|[s (=] [1[v] [=][<>[<][>] [anp][ or |[nor
e Click on [F|e|d]' then select Insert: Field Function » Import Formula...
Number > Custom Number > Formula for 'Avg Area Per Day' X
Area (sq m) (Numberl) Aol Edit formula
Click on [ /] to insert the e res ey Doy = _
division symbol, then click on larea (sq m) / [Actual Duraton |
[Field] and select Duration >
Actual Duration
CIickon[OK] I &|MoD|| \ || » 1) =l <> |« > |AND| OR |NOT
A message WI” dISplay Warning Insert: Field = Function « Import Formula...
you that existing data in the
Avg Area Per Day field will be o G Cancel
deleted. This is fine as we don'’t
have any data in this field...
Area (sq Awg Area Act. % Phys. % Act. Rem.
Cllck on [OK] tO CIOSe the Task Name * | m) : - PErJDa}- + Act.Start v Finish * Compv Comp. * Dur. v Du. =~
22 Install Bathroom 0 #ERROR NA NA 0% 0% Odays  2days
message, then on [OK] to 23 Final Electrical Fittings 0 #ERROR NA NA 0% 0% Odays  3days
close the dialog box 2 Final Plumbing Fittings 0 #ERROR NA NA 0% 0% Odays  2days
25 Paint External 710 HERROR NA NA 0% 0% Odays 5days
We have created an error 26 paint internals 925 #ERROR NA NA 0% 0% odays Gdays
which we will fix in the next a Council Approval 0 #ERROR NA NA 0% 0% Odays  lday
exercise 28 Construction Completed 0 #ERROR NA NA 0% 0% Odays  Odays
For Your Reference... Handy to Know...
To create a formula in a custom field: e There are various functions that you can use
1. Click on the Project tab, click on Custom in custom field formulas. For example, you
Fields, click on the field, then click on can include IF THEN clauses, convert
[Formula] values, or format dates and numbers.
2. Enter the formula using the [Field], e Before creating a formula for a custom field,
[Function] and mathematical buttons ensure that the field is not selected in the
3. Click on [OK] table.
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MODIFYING A FORMULA

You must check the values that appear in a
custom formula field. If you have made an error,
#ERROR may display. This makes it easy to see
when something is wrong — like in our case

Microsoft Project 2016 - Level 3

where we divided the area by zero (as Act.Dur. are

0 days) which is mathematically impossible.

Instead, we’'ll insert an IF THEN statement into the

formula to test when Actual Duration is zero.

Try This Yourself:

Continue using the previous file
with this exercise, or open the
file Custom Fields_4.mpp...

Same
File

In the Tracking table, display
the Custom Fields dialog box,
select Number in Type, click on
Avg Area Per Day, then click on
[Formula] to display the
Formula dialog box

Click at the start of the formula,
then click on [Function] >
General > IIf(... to insert the If
Then statement

Double-click on expression,
click on [Field] and insert
Duration > Actual Duration,
then type >0 (zero) to enter the
test

If the test is true we want to run
the formula...

Formula for 'Avg Area Per Day’ X

Edit formula
Avg Area Per Day =
IIf( expression, truepart, falsepart ) [Number‘l],-’[ActuaI Duration]

= - ([ %]/ & |MOD|| \ || & () = AND | OR || NOT

< |2 | =

Insert: Field = Function « Impart Formula..,

Help Cancel

Formula for 'Avg Area Per Day’ X

Edit formula
Avg Area Per Day =
IIf{ [Actual Duration] =0, [Number1]/[Actual Duration], 0 )

+ || - | = & |MOD|| \ || & () = AND | OR || NOT

< |2 | =

Select [Number1]/[Actual

Duration], then press |ctn] + X ] =
to cut the formula 23

Double-click on truepart, then

press |ct] + |V ] to paste the
formula 2

If it’s false we’ll make it zero...

Insert: Field = Function = Impart Formula..,
Help Cancel
Area (sq Avg Area Act. Phys. % Act. Rem.

Task Name * m) v PerDay v ActStart v Finish = Comp~v Comp. ¥ Dur. + Dur. ~
Install Bathroom 0 0 NA NA 0% 0% 0 days 2 days
Final Electrical Fittings 0 0 NA NA 0% 0% 0 days 3 days
24 Final Plumbing Fittings 0 0 NA NA 0% 0% Odays  2days
25 Paint External 710 0 NA NA 0% 0% Odays  Sdays
26 Paint internals 925 0 NA NA 0% 0% Odays  Gdays
27 Council Approval 0 0 NA NA 0% 0% 0 days 1day
Construction Completed 0 0 NA NA 0% 0% 0 days 0 days

Double-click on falsepart, then
type O

Click on [OK], then click on [OK]

The Act. Dur fields are currently
0 days so the formula appears to
be working

For Your Reference...
To modify a formula in a custom field:

1. Click on the Project tab, click on Custom
Fields, click on the field, then click on
[Formula]

2. Alter the formula as necessary using the
[Field], [Function] and mathematical
buttons

Handy to Know...

o |If statements have three components: the

expression represents the test (is Act. Dur >

07?), truepart says what will happen when

the test is true (if Act.Dur > 0, then do this...),

and falsepart says what will happen when
the test is false (if Act.Dur <=0, then do
this...).
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TESTING A FORMULA

When you insert a formula into a custom field, it
is important that you test for all situations. In the
previous exercise we determined that we needed
an IF THEN statement to test for cases when the

Microsoft Project 2016 - Level 3

actual duration is 0 days so that we wouldn’t be
trying to divide a value by 0. Now we must test that
the formula works when the actual duration is
greater than 0 days.

Try This Yourself:

Continue using the
previous file with this
exercise, or open the file
Custom Fields_5.mpp...

Same
File

In the Tracking table,
under Fit Out, click in the
Act. Dur. Column for
Paint External and type
2.5, press [nter], then type
4 to add the value for
Paint internals

Now that Act. Dur. have
values, we see that the
Avg Area Per Day has
values; however, the
values are too low...

Display the Formula
dialog box for the Avg
Area Per Day custom field

Project calculates Duration
fields in minutes so we
must convert our formula
accordingly. To do this we
must divide Actual
Duration by 480 to convert
it back to an 8-hour work
day...

Alter the truepart of the
formula as shown

Click on [OK] and then on
[OK]

The formula is definitely
working correctly now

Area (sq Avg Area Act. h Phys.% | Act Rem.

Task Name - m) w PerDay ~+ Act.Stat v Finish ~ Comp= Comp. v Dur. =+ Dur =~
Install Bathroom o 0 NA NA 0% 0% 0 days 2 days
Final Electrical Fittings 0 0 NA NA 0% 0% 0days 3 days
Final Plumbing Fittings 0 0 NA NA 0% 0% 0 days 2 days
Paint External 710 0.59 =ri 31/05/19 NA 50% 0% 2.5days 2.5 days
Paint internals 925 0.48 Fri 7/06/19 NA 67% 0% Adays  2days
Council Approval 0 0 NA NA 0% 0% |D days s 1day
Construction Completed 0 0 NA NA 0% 0% 0days 0 days

If 720 m? have been painted in 2.5 days, the average area per day

should be 284 m? (710 / 2.5) — not 0.59 m?, while the internal painting

should be 231.25 m2rather than 0.48 m2.

Edit formula
Avg Area Per Day =
lIf([Actual Durati

Formula for 'Avg Area Per Day' X

oo | FESTR & MODY N | [} =|| == |[=|[= AND | OR | NOT
Insert: Field = Function = Import Formula...
Help Cancel

c{ﬂﬂ,[NumbeH]j([Actual Duration]/ztst}],t}]]

Replace IIf ( [Ac

tual Duration] > 0, [Number1] / [Actual Duration], 0 )

with [If ( [Actual Duration] > 0, [Numberl] / ( [Actual Duration] / 480 ), 0)
Area (sq Avg Area Act, Phys. % Act. Rem.

Task Name v m) ~ PerDay ~+ Act.Stat v Finish ~+ Comp~v Comp. + |Dur. v Dur =
Install Bathroom 0 0 NA NA 0% 0% 0 days 2 days
Final Electrical Fittings o 0 NA NA 0% 0% 0 days 3 days
Final Plumbing Fittings 0 0 NA NA 0% 0% 0 days 2 days
Paint External 710 284 =ri 31/05/19 NA 50% 0% 2.5days 2.5days
Paint internals 925 231.25 Fri 7/06/19 NA 67% 0% 4days  2days
Council Approval 0 0 NA NA 0% 0% |0 days 3 1 day
Construction Completed 0 0 NA NA 0% 0% 0 days 0 days

For Your Reference...
To test a formula:

Handy to Know...

To calculate the Duration of one work day (8

hours) is 8 x 60 minutes = 480 minutes.
Therefore, the duration for 2.5 days is 1200.

1. Enter values into the relevant fields to check
that all components in the statement are
tested

2. Use a calculator, if necessary, to ensure that
calculated values are correct
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UNDERSTANDING GRAPHICAL INDICATOR CUSTOM FIELDS

Graphical indicator custom fields let you display such as finishing late. Using the Graphical

the value of a field graphically rather than Indicators dialog box you enter tests that Project
numerically. For example, you might use red will evaluate to determine which test passes and
images to highlight specific issues with tasks, hence which image it will insert into the field.

How Graphical Indicators Work

We have inserted a custom field called Cost Status into the standard Variance table. By using a
formula, we have set this field to be equivalent to the standard Cost Variance field (by simply selecting
[Cost Variance] in the Formula dialog box).

However, we don’t want to see the actual cost variance in the table; otherwise, we would have simply
inserted this field in the table. Instead, we’d like to see an overview of how each task is performing and
we will achieve this by adding graphical indicators to the custom field. This will enable us to see at a
glance tasks that are under budget (a green image will show when the cost variance is less than $0),
tasks that are on track (an orange image will show when the cost variance is less than or equal to $750),
and tasks that are over budget (a red image will show when the cost variance is greater than $750).

Graphical Indicator Tests

To create a graphical indicator custom field, you will need to access the Custom Fields dialog box, then
click on [Graphical Indicators] to open the Graphical Indicators dialog box for the selected field, as
shown below. This dialog box requires you to enter the appropriate tests that will be evaluated so that
Project can then insert the graphical image that represents the positive state of the test.

You will Graphical Indicators for "Cost Status” X
need to set Indicator criteria for
tests for (®) Nonsummary rows
each of (O) Summary rows
these row Summary rows inherit criteria from nonsummary rows
types- O Project summary
Project summary inherits criteria from summary rows The
Cut Row Copy Row Paste Row Insert Row Delete Row lapproprlalre
mage wi
These tests Test for 'Cost Status’ Value(s) Image ~ dlS ?a in
must cover is less than or equal to 0 O & play
all pOSSible is less than or equal to $750.00 [ Move the custom
Values. is greater than §750,00 Q- v field bfased
v on which
To display graphical indicators in place of actual data values, specify the value range for each indicator and the test iS
image to display. Tests are applied in the order listed and processing stops at the first successful test, ositive
Show data values in ToolTips p )

Help Import Indicator Criteria... Cancel

There are several important things to note when entering tests into the Graphical Indicators dialog box.

e You must specify as many tests as are necessary to cover all possible values of the particular
field. For instance, we have three tests to cover all situations for the Cost Status field as specified
above.

e You must enter the tests into the dialog box in the correct order. Project works by evaluating the
top test first and if that test passes, Project will insert the specified image into the field. If the first
test fails, Project moves onto the second test, evaluates it and if it passes, inserts the image
specified for that test. This continues until all tests have been evaluated, if necessary, and an
image has been inserted into the custom field in the table.

e You will need to enter tests for the three types of rows: nonsummary rows (which are simply all
of the work tasks), summary rows and the project summary. To do this you will need to access
the Graphical Indicators dialog box three separate times, one for each of the different types of
rows. If you want to use the same criteria in the Summary rows as you entered for the
nonsummary rows, you can simply click on Summary rows inherit criteria from nonsummary
rows. Likewise, you can use the same criteria in the Project summary as you entered for the
summary rows by clicking on Project summary inherits criteria from summary rows.
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CREATING GRAPHICAL INDICATOR CUSTOM FIELDS

Project table data typically appears as rows of exercise, we will add graphical indicators to a
data. But if you would like to see at a glance how custom field so that we can see which tasks are
tasks are tracking, you can display custom field under, on or over budget.

values graphically rather than numerically. In this

Graphical Indicators for "Cost Status” x
Try ThIS Yourself' Indicator criteria for
i i i @Nonsummary rows
S o Before starting this exercise O summary rows
8_ E you MUST open the file .Summary rows inherit criteria from nonsummary rows
O ™ Custom Fields_6.mpp... Oprojectsummary
- Project summary inherits criteria from summary rows
o DISplay the Variance table, Cut Row Copy Row Paste Row Insert Row Delete Row
I’ight-C"Ck on the COSt Status Test for "'Cost Status’ Value(s) Image ~
. N rFy
heading and select Custom is 1ess than or equal to ? 0.
Fields then CIiCk on is less than or equal to $750.00 .:':. Move
! . . is greater than S5750.00 ~ -
[Graphical Indicators] to L v
display the Graphical
Indicators dialog box for this e
field
e Click on the drOp arrow for Graphical Indicators for "Cost Status” >
Test for and select is less Indicator criteria for
than or equal to, type 0 in 82“’”‘“’“’“"’“’“"
Value(s)’ then SeIeCt the umsrz:::éitvrsaw's inherit criteria from nonsummary rows
green circle in Image — this @ Project summary
W||| ShOW under budget taSkS [] Project summary inherits criteria from summary rows
e |nsert the O'[hel' tWO tests as Cut Row Copy Row Paste Row Insert Row Delete Row
shown, Se|ecting orange and Test for 'Cast Status’ Value(s) Image *
red images respectively . --------
o Click on [OK], click on Ly
[Graphical Indicators], then
click on Summary rows e
o Click on Summary rows
inherit"' 1 then CIICk on [Yes] I‘I(;:ev Task Name - gtiit.g ~ Start » Finish + Baseline Start « Ei‘?:iiune -
so they use the same tests as 1 | = <] Plansand site | @ Tue5/02/19  Thu28/03/19 NA NA
the work tasks 2 [mg Create Site Plz () Tues5/02/19  Wed 6/02/19 NA NA
. 3 |wy Arrange Counc () Thu7/02/19  Thu 7/02/19 MA MNA
e Repeat step 4 but click on 4 |m preparesite | @ Thu28/02/19  Wed 6/03/19 NA NA
Project summary, then 5 |mg Organise Mate () Thu28/02/19  Thu28/02/19 NA NA
ensure that Project 6 |mg Lay Foundatiol @ Thu7/03/19  Fri22/03/19 NA NA
summary inherits... appears 7 |wm Plumbing fors () Mon 25/03/19  Tue 26/03/19 NA NA
ticked 8 |wy Pour Slab @ Wwed 27/03/19  Thu 28/03/15 NA NA
9 |wg Foundations ¢ @ Thu 28/03/19  Thu 28/03/19 NA NA
Click on [OK] for each dialog 0 | 4 To Lock Up @ Fri20/03/19  Fri26/04/19 NA NA
box. then click in another field 11 | Erect Framing @ Fri2g9/03/19  Tue 2/04/19 NA NA
S0 you can see the results o
For Your Reference... Handy to Know...
To insert graphical indicators into a custom field: e You can create a custom field (using a
1. Right-click on the custom field heading and formula to make it equivalent to the standard
select Custom Fields, then click on Finish Variance field) to show graphically all
[Graphical Indicators] tasks that finished ahead of schedule (is less

than or equal to 0d), on time (is less than or

2. Insert tests for nonsummary rows, summary aEll® B1)), 07 [l (3 6ae s G 51)

rows and the project summary
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CREATING A Lookup Cus

You can make data entry faster and more
accurate by creating lookup tables of valid
options from which to choose. Lookup tables
work for all custom fields types except flag fields

Microsoft Project 2016 - Level 3

TOM FIELD

as they have only two options: yes and no. For
outline fields, which we’ll use, you can set up a
template for the rules that the field values have to
follow. We’'ll start by creating an outline code field.

Try This Yourself:

Continue using the previous
file with this exercise, or
open the file Custom
Fields_7.mpp...

Same
File

Click on the Project tab,
click on Custom Fields, then
select Outline Code in Type

Ensure that Outline Codel
is selected, click on
[Rename], type Account
Code in New name for, then
click on [OK]

Now we need to specify that
this is a lookup table field...

Click on [Lookup] under I

Custom attributes to
display the Edit Lookup
Table dialog box

Here you can either simply
enter the values and
description in the rows, or
first set up a code mask to
define the rules that each
code must comply with...

Click on + beside Code
mask (optional) at the top of
the dialog box to expand this
section

Now you can see the code
preview as well as have
access to the [Edit Mask]
command.

Leave this dialog box open
for the next exercise

Values to d

|

Custom Fields X

Field

(®) Task () Resaurce Project Type: Outline Code  ~~
Field [ ~

Account Code (Outline Code)
Cutline Code2
Cutline Code3
Cutline Coded
COutline Code5
Cutline Codet
Cutline Code?

W

Rename.., Delete Add Field to Enterprise... Import Field..,

Custom attributes
Mone @

Calculation for task and group summary rows

Lookup... Formula..

Mone Rollup: Use formula

CEICUIEtiOHI Edit Lockup Table for Account Code

Mone
m Code mask [optional)

You can edit the mask for the lookup
table, including adding or deleting
levels.

Edit Mask...
Data

Prewl

He"’l _| Lookup table

=)
=

& B @ = + | =

Value Description

Move

Display indenting in lookup table
Dgse a value from the table as the default entry for the field
Set Default [Click button after selecting a value above)

= | Display order for lookup table

= Data entry options

Help Import Lookup Table.., Close

For Your Reference...

To create a custom field with a lookup table:
1. Click on the Project tab, then click on
Custom Fields in the Properties group
Select the appropriate Data type, then

rename the new field

2.

3.
values and descriptions

Click on [Lookup], then enter the required

Handy to Know...

Outline code custom fields contain an
alphanumeric code that you define to
represent a hierarchical structure of tasks or
resources. You can use them to group tasks
or resources. For example, you can create
outline codes to represent job codes or
accounting cost codes associated with tasks.

© Watsonia Publishing
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CREATING AN OUTLINE CODE MASK

When you are creating a lookup table for an outline code must follow. We’'ll define two outline
outline code custom field, you can choose to levels: the first comprising four characters and the
create a code mask. A code mask is a template second comprising three numbers.

that comprises the rules that all values for this

Code Mask Definition for Account Code * .
. . e Notice the
Try This Yourself: Code previews [ | code
i i i Code mask: preview: the
Continue USIng the pl’eVIOUS Level Sequence Length Separator |A asterisks (*)
file with this exercise... T Characters 4. represent the
|Numbers 3 |l four
o Click on [Edit Mask] to display — characters
the Code Mask Definition ] and the 1s
dialog box represent the
. v three
Let’s define Level 1... numbers in
a Hel oK G |
e Ensure that Characters is — - — the code.
selected in Sequence, then
CIICk_ n Length and type 4' o Edit Lookup Table for Account Code *
leaving the full stop as the _
Separator _ | Code mask [optional)
You can edit the mask for the lookup Edit Mask...
9 Click in Sequence in the next table, including adding or deleting -
row, click on the drop arrow e prey ———-—
and select Numbers, then ~| Lookup table
type 3 in Length
o 2 % EE: w] [=] %
Click on [OK] to return to the ron | ™A Description &
Edit Lookup Table dialog box |
Leave this dialog box open for l:
the next exercise ||
: Move
] v
Display indenting in lookup table
Dgse a value from the table as the default entry for the field
Sef Default  [Click button after selecting a value above)
~ | Display order for lookup table
= | Data entry options
Help Import Lookup Table...
For Your Reference... Handy to Know...
To create a code mask for an outline code field: e You can specify as many outline levels as
1. Display the Custom Fields dialog box for required for an outline code lookup table.
the field ¢ Inthe Sequence field you can choose from
2. Click on [Lookup], expand Code mask, Characters, Numbers, Uppercase Letters
then click on [Edit Mask] and Lowercase Letters.

3. Specify the levels, each with their sequence,
length and separator
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ENTERING LOOKUP TABLE VALUES

Using the Edit Lookup Table dialog box you can
add the required values and their descriptions to
the lookup table. Because we created a code
mask in the previous exercise, we need to enter

the values carefully so that they conform to the
rules specified in the mask. As well as adding
values, you can also specify other options such as
the display order, default value, and more.

Try This Yourself: e

Continue using the previous file with
this exercise...

In the Edit Lookup Table dialog
box, type Plan in the first Value
field, then click in Description and
type Planning

Type 100 in the second Value field,
then click in Description

The value will be red because you e
haven't typed four characters. We

need to tell Project this value is
actually a second level value...

Click on Indent (right pointing |
arrow), then type Residential
Planning

Type 200 in the next Value field, |
then type Industrial Planning in
Description

Type Cons in the next Value field,
then click in Description

Again you’ll get another error. This
time the value must be outdented to
level 1...

Click on Outdent, type
Construction in Description, then
complete the details as shown

©

Expand Data entry options, then
click on Allow only codes that
have no subordinate values so it
appears ticked

Click on [Close], then click on [OK]

Edit Lockup Table for Account Code *
_ | Code mask [optional)
You can edit the mask for the lookup Edit Mask
table, including adding or deleting Sl
levels.
#**111

_ | Lookup table

& B |S=| 3x| « *| [+ |-

Row Value Description |"

1 Flan Planning

2| 100 |

Edit Lookup Table for Account Code *
_ | Code mask [optional)

I You can edit the mask for the lookup Edit Mask...
table, including adding or deleting = =
levels.

T
_ | Lookup table
| Row Walue Description i
1 |4 Plan Planning
2 100 Residential Planning
3 200 Industrial Planning
4 |4 Cons Construction
5 100 Residential Construction
6 | 200 Industrial Construction Move
W
Display indenting in lookup table
Use a value from the table as the default entry for the field
Set Default [Click button after selecting a value above)
= | Display order for lookup table
- | Data entry options
Help Import Lookup Table...

For Your Reference...

To enter values in an outline code lookup table:

1. Display the Custom Fields dialog box for
the field, then click on [Lookup]

2. Type the values (in/outdenting as needed)
and descriptions obeying the code mask if
one has been set

3. Set other options as required

Handy to Know...

e To enter details in the outline code rows that
contain very similar details, use the Copy

Row and Paste Row tools in the Edit

Lookup Table dialog box.

e Ensure that the Display indenting in

lookup table option is selected.
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